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Documentation Updates 

This guide’s title page contains the following identifying information: 

• Software Version number, which indicates the software version. 

• Document Release Date, which changes each time the document is updated. 

• Software Release Date, which indicates the release date of this version of the software.


To check for recent updates, or to verify that you are using the most recent edition of a document, go to:


http://h20230.www2.hp.com/selfsolve/manuals 

This site requires that you register for an HP Passport and sign-in. To register for an HP Passport ID, go to: 

http://h20229.www2.hp.com/passport-registration.html 

Or click the New users - please register link on the HP Passport login page.


You will also receive updated or new editions if you subscribe to the appropriate product support service.


Contact your HP sales representative for details.
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Support 

You can visit the HP Software Support web site at: 

www.hp.com/go/hpsoftwaresupport 

HP Software online support provides an efficient way to access interactive technical support tools. As a valued 
support customer, you can benefit by using the support site to: 

• Search for knowledge documents of interest


• Submit and track support cases and enhancement requests


• Download software patches


• Manage support contracts


• Look up HP support contacts


• Review information about available services


• Enter into discussions with other software customers


• Research and register for software training


Most of the support areas require that you register as an HP Passport user and sign in. Many also require a

support contract.


To find more information about access levels, go to:


http://h20230.www2.hp.com/new_access_levels.jsp 

To register for an HP Passport ID, go to: 

http://h20229.www2.hp.com/passport-registration.html 
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1 Overview 

This chapter covers the following topics: 

• HP Performance Insight 

• Enhancements in Version 3.40 

•  Data Collection  

• Folders and Reports 

• Integration with Network Node Manager 

• Options for Customizing Reports 

• Sources for Additional Information 

HP Performance Insight 

HP Performance Insight collects data from many sources, performs in-depth trend analysis, 
maintains performance baselines, and provides users with convenient, web-based reporting. 
Following is a partial list of product features: 

• Distributed architecture 

• Easy to scale (supports data collection from thousands of agents) 

• CODA/PA agent support 

• Multi-company security model 

• Data warehousing 

• Near Real Time reporting 

• Forecasting 

• Extensive aggregation (by day, week, month; by location, by customer) 

• Thresholding and alerting 

• Bottlenecks easy to spot; capacity trends easy to assess 

• Accurate and timely documentation for management 

The reporting solutions created for Performance Insight cover many areas of business 
technology optimization. For a list of reporting solutions organized by technology, see 
Appendix B, PI Report Packs. 
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Device Resource Report Pack 

The reports in this package monitor CPU, memory, and buffer resources in switches, routers, 
the switch backplane, and cards installed on devices. Resources function independently. If a 
buffer is overutilized, the CPU that moves data in and out of the buffer could be 
underutilized; if the CPU is overutilized, buffer and memory could be underutilized. The 
Device Resource Report Pack does not monitor server resources. Use the System Resource 
Report Pack to monitor server resources. 

You have synergies to exploit by running Device Resource with Interface Reporting. If IR is 
showing high discards or high errors, DR will tell you if overutilization of a resource could be 
contributing to the problem. You can also move in the reverse direction. If DR indicates that 
network response time is spiking, the reports in IR will tell you if interface utilization levels 
are contributing to the problem. 

Enhancements in Version 3.40 

Copy Policy Enhancement 

The copy policy enhancement makes it easier to set up a distributed system. The 
enhancement involves changes to Datapipe Manager and the addition of a copy policy import 
file. Datapipe Manager parses the copy policy import file when you install the report pack on 
the central server. Parsing the file creates copy policies. You no longer have to create copy 
policies yourself using the Management Console. Instead, your only task related to copy 
policies is to verify that the copy policies you need already exist. 

The copy policy enhancement applies to the main package only; it does not apply to the 
Device Resource Backplane sub-package. 

Upgrade Packages 

• DevResAlcatelXylanSwitch_DP_Upgrade_21_to_22 

• DevResCiscoRouter_Datapipe_Upgrade_to_31 

• DevResCiscoSwitch_Datapipe_Upgrade_to_32 

• DevResEnterasysRouter_Datapipe_Upgrade_to_11 

• DevResEnterasysSwitch_Datapipe_Upgrade_to_11 

• DevResExtremeDevices_Datapipe_Upgrade_to_21 

• DevResHPProCurveSwitch_Datapipe_Upgrade_to_31 

• DevResJuniperRouter_Datapipe_Upgrade_to_11 

• DevResNortelBRouter_Datapipe_Upgrade_to_31 

• DeviceResourceBackplane_Upgrade_to_33 

• DeviceResource_Upgrade_to_34 

Data Collection 

The following vendor-specific datapipes collect data for Device Resource main package: 

• Dev Res 3COM Router Datapipe 
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• Dev Res Alcatel Xylan Switch Datapipe 

• Dev Res Cisco Switch Datapipe 

• Dev Res Cisco Router Datapipe 

• Dev Res Enterasys Router Datapipe 

• Dev Res Enterasys Switch Datapipe 

• Dev Res Extreme Devices Datapipe 

• Dev Res Foundry Datapipe 

• Dev Res HP ProCurve Datapipe 

• Dev Res Juniper Router Datapipe 

• Dev Res Nortel Bay Datapipe


The following vendor-specific datapipes collect data for Device Resource Backplane:


• Dev Res Alcatel Xylan Switch Datapipe


• Dev Res Cisco Switch Datapipe


In addition to performance data, reports contain the following kinds of property information:


• IP addresses


• Host names


• Customers


• Locations


Property information is stored in tables maintained by Common Property Tables. If you are 
about to install Common Property Tables for the first time, you will not see customers or 
locations in reports until you import this information. You can import customers and locations 
in batch mode by creating and importing a file, or you can import customers and locations 
using the “create new” forms bundled with Common Property Tables. For details about 
importing properties, refer to the Common Property Tables User Guide. 

Folders and Reports 

Device Resource main package contains 15 reports. The report folders are: 

• Customer (3 reports) 

• Device (9 reports) 

• Location (3 reports)


Device Resource Backplane sub-package contains 5 reports. The report folder is:


• Backplane (5 reports)


The following table indicates the contents of each folder.


Report Type Customer Device Location Backplane 

Exceptions Summary X 

Card Historical Summary X 

Historical Summary X X 
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Report Type Customer Device Location Backplane 

Historical Summary Snapshot X 

QuickView X 

Snapshot X 

NRT QuickView X X 

NRT Snapshot X X 

Forecast X X X 

Service Level Management X 

Summary X X 

Top Ten  X  X  X  

Integration with Network Node Manager 

If you use NNM as well as PI, you have the option of improving your ability to isolate faults 
and diagnose problems by integrating PI with NNM. Integrating PI and NNM is explained in 
the NNM/PI Integration Guide. Integration involves running a script on NNM and launching 
the Integration Wizard on PI. (Installing integration packages on NNM and PI is no longer 
necessary.) 

If NNM and PI are integrated, be sure to install the thresholds sub-package that comes with 
Device Resource. Installing the thresholds sub-package configures the Thresholds Module to 
detect threshold conditions related to CPU, buffer, and memory utilization. The Thresholds 
Module will respond to a threshold condition by sending a breach trap to NNM. The breach 
trap becomes an alarm in the NNM alarm browser, which the NNM operator can respond to 
by launching a Near Real Time report. 

Configuring the Thresholds Module is not necessary. You do not need to define an action or 
specify a destination for breach traps. However, you may want to modify category, severity, 
and destination parameters. For details, see the Thresholds Module User Guide. 

Options for Customizing Reports 

You can customize reports by applying group filters, by applying constraints, by editing tables 
and graphs, and by importing property information (node names, host names, customers, and 
locations). Service providers, or any organization that wants to share reports with customers, 
will need group filters to create customer-specific reports. However, any user viewing a report 
can apply a constraint, edit tables, and edit graphs. 

Group Filters 

If you want to share reports with your customers, you must configure PI to produce 
customer-specific reports. Here is an overview of the steps involved: 

• Use Common Property Tables to import customer names and device locations 
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• Create a group account for all the users affiliated with each customer 

• Create a group filter for each group account 

For more information about creating filters, refer to the HP Performance Insight 
Administration Guide. 

Applying Constraints 

Editing a parameter applies a constraint to the report. The constraint eliminates the data you 
are not interested in. For example, if you edit the Customer Name parameter, data for every 
customer except the customer you typed in the Customer Name field drops from the report. 
Device Resource supports the following parameters: 

• Customer Name 

• Customer ID 

• Location Name 

• Location ID 

• Device Name 

• Make 

• Model 

If you are using a web browser to view reports, edit parameters by clicking the Edit 
Parameters icon at the bottom right-hand corner of the report. When the Edit Parameters 
window opens, enter the constraint in the field and click Submit. If you are using Report 
Viewer, select Edit > Parameter Values from the menu bar. When the Modify Parameter Values 
window opens, click the Current Value field. Type a new value and click OK. 

Sources for Additional Information 

This user guide provides samples of some of the reports in Device Resource. The demo 
package that comes with Device Resource is complete, containing a sample of every report in 
the package. If you have access to the demo package and you want to know what 
fully-populated reports look like, install the demo package. Demo reports are interactive, but 
unlike real reports the data in a demo report is static. 

The following documents are related to this manual: 

• Executive Summaries Report Pack User Guide 

• Common Property Tables User Guide 

• NNM/PI Integration User Guide 

• Thresholds Module User Guide 

• HP PI Report Packs, version 14.00, CD-ROM Release Notes, February 2009

Information about bug fixes and recent changes to datapipes can be found in the following 
release notes: 

• Device Resource Report Pack Release Notes 

• Device Resource Backplane Report Pack Release Notes 

• Dev Res 3COM Router Datapipe Release Notes 
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• Dev Res Alcatel Xylan Switch Datapipe Release Notes 

• Dev Res Cisco Switch Datapipe Release Notes 

• Dev Res Cisco Router Datapipe Release Notes 

• Dev Res Enterasys Router Datapipe Release Notes 

• Dev Res Enterasys Switch Datapipe Release Notes 

• Dev Res Extreme Devices Datapipe Release Notes 

• Dev Res Foundry Datapipe Release Notes 

• Dev Res HP ProCurve Datapipe Release Notes 

• Dev Res Juniper Router Datapipe Release Notes 

• Dev Res Nortel Bay Datapipe Release Notes 

You can download manuals for PI and the reporting solutions and shared packages that 
run on PI from this site: 

http://h20230.www2.hp.com/selfsolve/manuals 

The user guides for PI are listed under Performance Insight. The user guides for report packs 
and datapipes are listed under Performance Insight Report Packs. Every guide indicates a date. 
If a guide is revised and reposted, the date will change. Since we post revised manuals on a 
regular basis, be sure to compare the date on your PDF to the date of the web edition and 
download the web edition if it is newer. 
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2 Upgrade Install

This chapter covers the following topics: 

• Guidelines for a Smooth Upgrade 

•  Upgrading to Device Resource 3.40 

• Post-Installation Steps 

• Removing Device Resource 

Guidelines for a Smooth Upgrade 

If you ran the package extraction program, the upgrade packages for Device Resource, as well 
as the latest version of the datapipes used by Device Resource, are already in the Packages 
direction on your system awaiting installation. Start Package Manager and follow the 
familiar on-screen instructions for upgrading a report pack. 

If the extraction step has not taken place yet, insert the report pack CD in the CD-ROM drive 
and use the package extraction program to copy packages from the CD to the Packages 
directory on your system. After the extract finishes, the install script prompts you to start 
Package Manager. Before using Package Manager, review the following guidelines: 

• Software prerequisites for Device Resource 

• Datapipes and remote pollers 

• Custom table views 

• Upgrading Device Resource in a distributed environment 

Software Prerequisites for Device Resource 

Version 3.40 of Device Resource has the following prerequisites: 

• Performance Insight 5.40 

• All service packs available for PI 5.40 

• Common Property Tables 3.90 

Upgrading in a Distributed Environment 

If you set up a distributed systems using an earlier version of Device Resource, you probably 
created a distributed environment by using DS EDIT to set up connections with satellite 
server databases. In addition, you probably configured trendcopy pull commands from the 
central server and switched off hourly aggregations at each satellite server. 

Following is an overview of the upgrade procedure for a distributed environment: 
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1 Disable trendcopy on the central server. 

2 For the central server: 

• Upgrade to Common Property Tables 3.9; deploy reports 

• Upgrade to Device Resource 3.40; deploy reports 

3 For each satellite server: 

• Upgrade to Common Property Tables 3.90 

• Upgrade to Device Resource 3.40 

4 Re-enable trendcopy on the central server. 

5 Reconfigure central and satellite servers. 

For details about reconfiguring central and satellite servers, see Chapter 4, Setting Up a 
Distributed Systems. 

Datapipes and Remote Pollers 

If you uninstall an existing datapipe, you will lose the following information: 

• Single polling policy for a remote poller 

• Cloned polling policies for multiple remote pollers 

• Customized polling groups 

To prevent this information from being lost, you can export existing polling policy 
configurations and customized polling groups by using the following commands: 

• collection_manager 

• group_manager 

Exporting Polling Policy Configurations 

If your environment contains polling policies for remote pollers, use the collection_manager 
command to export existing policy configurations to a file. 

UNIX: As user trendadm, run the following command: 

cd $DPIPE_HOME


./bin/collection_manager -export -file /tmp/savePollingPolicy.lst


Windows: As Administrator, launch a command window. Navigate to the PI install directory 
and execute the following command: 

bin\collection_manager -export -file \temp\savePollingPolicy.lst


Exporting Polling Group Configurations 

If your environment contains customized polling groups, use the group_manager command to 
export groups to individual .xml files. 

UNIX: As user trendadm, execute the following command: 

cd $DPIPE_HOME


./bin/group_manager -export_all -outfile /tmp/savePollingGroups
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Windows: As Administrator, launch a command window, then navigate to the PI install 
directory and execute the following command: 

bin\group_manager -export_all -outfile \temp\savePollingGroups


Custom Table Views 

If you created one or more custom views for tables, the views you created may interfere with 
the report pack upgrade process, causing the process to fail. Whether your views interfere 
with the upgrade process depends on how you created them. If you created them using SQL, 
the upgrade will succeed but your views will not be available once the upgrade is complete. If 
you created them using Datapipe Manager, the upgrade is likely to fail. To prevent the 
upgrade from failing, delete custom table views before you upgrade the report pack, then 
recreate the views after the report pack is upgraded. 

Upgrading to Device Resource 3.40 

To upgrade Device Resource on a stand-alone system, perform the following tasks: 

Task 1: If necessary, save configuration data related to polling policies and polling groups. 

Task 2: Upgrade to Common Property Tables 3.90. 

Follow these rules: 

•	 Do not install any other package with the Common Property Tables upgrade package; 
install the Common Property Tables upgrade package and only the Common Property 
Tables upgrade package. 

•	 When prompted to accept or disable the option to Deploy Reports, accept the default. If 
you do not deploy reports, you will not deploy the change forms that come with Common 
Property Tables. 

• When the install finishes, click Done to return to the Management Console. 

If you need more help with this task, refer to the Common Property Tables User Guide. 

Task 3: Remove the Dev Res Alcatel Xylan Switch Datapipe, if installed 

The Dev Res Alcatel Xylan Datapipe cannot be upgraded. You must remove this datapipe and 
install Dev Res Alcatel Xylan Datapipe 2.20. Start Package Manager and follow the on-screen 
instructions for package removal. When Package Manager tells you that removal is complete, 
click Done to return to the Management Console. 

Task 4: Install Dev Res Alcatel Xylan Datapipe 2.20 

1 Start Package Manager. The Package Manager welcome window opens. 

2 Click Next. The Package Location window opens. 

3 Click Install. 

4 Click Next. The Report Deployment window opens; disable the default for Deploy Reports. 

5 Click Next. The Package Selection window opens. 

6 Click the check box next to the following package: 
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Dev Res Alcatel Xylan Datapipe 2.2 

7 Click Next. The Type Discovery window opens. 

8 Click Next. The Selection Summary window opens. 

9 Click Install. The Installation Progress window opens and the install begins. When the 
install finishes, the package installation complete message appears. 

10	 Click Done. 

Task 5: Install the upgrade package for Device Resource 3.40 

1 From the Management Console, select Tools > Package Manager. The Package Manager 
welcome window opens. 

2	 Click Next. The Package Location window opens. 

3	 Click Install. 

4	 Click Next. The Report Deployment window opens. Accept the defaults for Deploy Reports, 
Application Server, and Port. Type your user name and password for the PI Application 
Server. 

5	 Click Next. The Package Selection window opens. 

6	 Click the check box next to the following packages (depending on which packages you are 
upgrading): 

UPGRADE_DeviceResource_to_34.ap 

UPGRADE_DeviceResourceBackplane_to_33.ap 

UPGRADE_DevResEnRouter_to_11.ap (if the Enterasys Router datapipe is installed) 

7	 Click Next. The Type Discovery window opens. Disable the default. 

8	 Click Next. The Selection Summary window opens 

9	 Click Install. The Installation Progress window opens and the install begins. When the 
install finishes, a package install complete message appears. 

10	 Click Done. 

Post-Installation Steps 

Once Device Resource has been upgraded, your first step is to reconfigure any polling policies 
and customized group definitions that need to be restored. Do not re-import the configurations 
you exported. Because the old datapipe may be incompatible with the new datapipe you just 
installed, re-importing a configuration you exported could lead to data corruption. In addition, 
if you deleted any custom table views, you can recreate those custom views now. 

Removing Device Resource 

Removing Device Resource automatically removes any datapipe that depends on Device 
Resource. Follow these steps to uninstall the Device Resource package. 

1 Log in to the system. On UNIX systems, log in as root. 
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2 Stop OVPI Timer and wait for processes to terminate. 

On Windows, do the following: 

a Select Control Panel > Administrative Tools > Services. 

b Select OVPI Timer from the list of services. 

c From the Action menu, select Stop. 

On UNIX, as root, do one of the following:


HP-UX: sh /sbin/init.d/ovpi_timer stop


Sun: sh /etc/init.d/ovpi_timer stop


3	 Start Package Manager and follow the on-screen directions for uninstalling packages; 
when prompted, select Device Resource for removal. When the uninstall process finishes, 
a package removal complete message appears. 

4	 Click Done. 

5 Restart OVPI Timer. 

On Windows, do the following: 

a Select Control Panel > Administrative Tools > Services. 

b Select OVPI Timer from the list of services. 

c From the Action menu, select Start. 

On UNIX, as root, do one of the following: 

HP-UX: sh /sbin/init.d/ovpi_timer start 

Sun: sh /etc/init.d/ovpi_timer start 
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3 The New Install 

This chapter covers the following topics: 

• Guidelines for a Smooth Install 

• Installing Device Resource 

• Removing Device Resource 

Guidelines for a Smooth Install 

Our reporting solutions have two ingredients, a report pack and a datapipe. Some reporting 
solutions include multiple datapipes. Installing a datapipe configures PI to collect a specific 
type of performance data at a specific interval. Installing a report pack configures PI to 
summarize and aggregate the data collected by the datapipe. 

When you insert the report pack CD in the CD-ROM drive and launch the package extraction 
program, the install script copies packages from the CD to the Packages directory on your 
system. After the extract finishes, the install script prompts you to start the install wizard, 
Package Manager. Before running Package Manager, review the following guidelines. 

Software Prerequisites 

Device Resource 3.40 has the following prerequisites: 

• HP Performance Insight 5.40 

• All service packs available for PI 5.40 

• Common Property Tables 3.90 

If you are not currently running any version of Common Property Tables, let Package 
Manager install version 3.90 for you. If you are running an earlier version of Common Property 
Tables, upgrade to version 3.90. Installing the upgrade packages for Common Property Tables 
is easy. However, if you need assistance or if you want to know more about how this package 
operates, refer to the Common Property Tables User Guide. 

Datapipes 

The datapipes that collect data for this report pack are not prerequisites. You may install the 
datapipes when you install the report pack or you may install the datapipes after you install 
the report pack. The following datapipes are available for installation: 

• Dev Res 3COM Datapipe 2.00 

• Dev Res Alcatel Xylan Datapipe 2.20 

• Dev Res Cabletron Datapipe 1.00 
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• Dev Res Cisco Router Datapipe 3.10 

• Dev Res Cisco Switch Datapipe 3.20 

• Dev Res Enterasys Router Datapipe 1.10 

• Dev Res Enterasys Switch Datapipe 1.10 

• Dev Res Extreme Devices Datapipe 2.10 

• Dev Res Foundry Datapipe 2.00 

• Dev Res HP ProCurve Datapipe 3.10 

• Dev Res Juniper Router Datapipe 1.10 

• Dev Res Nortel Bay Datapipe 3.10 

Thresholding and Alarms 

If your PI and NNM servers are integrated, be sure to install the thresholds sub-package, 
Device_Resource_Thresholds, on your PI server. This package contains customized 
thresholds. If you install it, the threshold traps generated by PI will display as alarms in the 
NNM alarm browser. 

If you install the thresholds sub-package, Package Manager will install the Thresholds 
Module for you, automatically. The Thresholds Module controls the actions that PI takes in 
response to a threshold breach. For details about configuring new actions, see the Thresholds 
Module User Guide. 

Distributed Environments 

If you intend to run Device Resource in a distributed environment, the installation procedure 

is more complex. Here is an overview of the steps:


1 Make sure that every server is running PI 5.40.


2 Make sure that every server is running all available service packs for PI 5.40.


3 Disable trendcopy on the central server.


4 Install the following packages on the central server:


• Device Resource; deploy reports 

• Device Resource Thresholds (optional) 

• Device Resource Backplane; deploy reports 

• Device Resource Thresholds Backplane (optional) 

• Common Property Tables 3.90; deploy reports (forms in this context) 

5 Install the following packages on each satellite server: 

• Device Resource; deploy reports only if you want local reporting 

• Device_Resource_Thresholds (optional) 

• Device Resource Backplane 

• Device Resource Thresholds Backplane (optional) 

• Common Property Tables 3.90 

• At least one datapipe 
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6 Re-enable trendcopy on the central server. 

7 Configure the central server and each satellite server. For details, see Chapter 4, Setting 
Up a Distributed Systems. 

Installing Device Resource 

Follow these steps to install Device Resource: 

1 Log in to the system. On UNIX® systems, log in as root. 

2 Stop OVPI Timer and wait for processes to terminate. 

On Windows, do the following: 

a	 Select Control Panel > Administrative Tools > Services. 

b Select OVPI Timer from the list of services. 

c From the Action menu, select Stop. 

On UNIX, as root, do one of the following: 

HP-UX: sh /sbin/init.d/ovpi_timer stop 

Sun: sh /etc/init.d/ovpi_timer stop 

3	 Insert the report pack CD in the CD-ROM drive. 

Windows: The Main Menu opens automatically. 

UNIX: 

a Mount the CD (if the CD does not mount automatically). 

b Navigate to the top level directory on the CD. 

c Run ./setup 

4 Type 1 in the choice field and press Enter. 

After the install script has copied every package to the Packages directory on your system, 
follow the prompts to launch Performance Insight and start Package Manager. The 
Package Manager welcome window opens. 

5 Click Next. The Package Location window opens. 

6	 Click Install. 

7	 Approve the default destination directory or browse to a different directory, if necessary, 
and click Next. The Report Deployment window opens. Type your username and password 
for the PI Application Server 

8 Click Next. The Package Selection window opens. 

9 Click the check box for the following packages: 

Device Resource 3.4


Device Resource Thresholds (optional)


Device Resource Demo Package (optional)


Device Resource Backplane sub-package (optional)


Device Resource Backplane Thresholds sub-package (optional)
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10 Click the check box for at least one datapipe.


11 Click Next. The Type Discovery window opens.


12 To run Type Discovery immediately after package installation, accept the default and

click Next. The Selection Summary window opens. 

13	 Click Install. The Installation Progress window opens and the install begins. When the 
install finishes, a package installation complete message appears. 

14	 Click Done. 

15	 Restart OVPI Timer.


On Windows, do the following:


a	 Select Control Panel > Administrative Tools > Services. 

b Select OVPI Timer from the list of services.


c From the Action menu, select Start.


On UNIX, as root, do one of the following:


HP-UX: sh /sbin/init.d/ovpi_timer start 

Sun: sh /etc/init.d/ovpi_timer start 

Options for Viewing Reports 

When you installed Device Resource, you enabled the Deploy Reports option. As a result, the 
reports in this package (as well as any associated forms) were deployed to the PI Application 
Server. Once reports reside on the PI Application Server, you have two ways to view them: 

•	 PI client applications 

•	 Web browser 

If the client applications are installed on your system, you have access to Report Viewer, 
Report Builder, and the Management Console. If the clients are not installed on your system, 
using a web browser is the only way you can view reports. 

For more information about the client applications, refer to the PI Installation Guide. For 
more information about the Management Console, including how to use the Object/Property 
Management view to launch reports, refer to the HP Performance Insight Administration 
Guide. 

Seeing Performance Data 

Some reports populate with data sooner than others. The first report to populate with data is 
the Near Real Time report. You will begin to see data in this report immediately after the first 
data collection completes. 

Any report that begins with an analysis of yesterday’s performance will need at least one full 
day’s worth of data before results are viewable. You will begin to see forecast data soon, within 
a few days. However, you will need to wait about six weeks for reliable forecast data, since the 
rolling baseline will not be complete until then. 
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Removing Device Resource


Removing Device Resource automatically removes any datapipe that depends on Device 
Resource. Follow these steps to uninstall the Device Resource package. 

1 Log in to the system. On UNIX systems, log in as root. 

2 Stop OVPI Timer and wait for processes to terminate.


On Windows, do the following:


a	 Select Control Panel > Administrative Tools > Services. 

b Select OVPI Timer from the list of services.


c From the Action menu, select Stop.


On UNIX, as root, do one of the following:


HP-UX: sh /sbin/init.d/ovpi_timer stop 

Sun: sh /etc/init.d/ovpi_timer stop 

3 Start Package Manager and follow the on-screen directions for uninstalling packages; 
when prompted, select Device Resource for removal. When the uninstall process finishes, 
a package removal complete message appears. 

4	 Click Done. 

5	 Restart OVPI Timer. 

On Windows, do the following: 

a	 Select Control Panel > Administrative Tools > Services. 

b Select OVPI Timer from the list of services.


c From the Action menu, select Start.


On UNIX, as root, do one of the following:


HP-UX: sh /sbin/init.d/ovpi_timer start


Sun: sh /etc/init.d/ovpi_timer start

The New Install 25 



26 Chapter 3 



4 Setting Up a Distributed Systems

These are the steps to follow when setting up a distributed system: 

•	 Decide whether or not you want local reporting 

•	 Install the right set of packages on each server (a central server that is not polling will not 
need datapipes; the satellite servers will need datapipes) 

•	 Verify that the system clocks in your environment are synchronized 

•	 Register your satellite servers 

•	 If you are not copying rate data to the central server, enable LIR on the central server 

•	 If you enable LIR, add LIR mapping with the time type set to rate 

•	 Verify that you have all the copy policies you need 

•	 Configure the central server (manual edits to trendtimer.sched and .pro files) 

•	 Configure each satellite server (manual edits to trendtimer.sched and .pro files) 

If you want to set up a distributed system, you can implement local reporting or you can 
implement centralized reporting. If you want local reporting, you need to deploy reports when 
you install the report pack on each satellite server, and you need to allow summarizations to 
run on each satellite server. If you do not want local reporting, then you do not need to deploy 
reports when you install a report pack on a satellite server and you can disable the scripts 
that run summarizations on each satellite server. 

Before Location Independent Reporting (LIR) was available, our recommendation to anyone 
setting up a distributed system was to deploy reports on satellite servers, keep rate data on 
satellite servers, copy hourly data to the central server, and disable summarizations above the 
hourly level on satellite servers. The advantage to this approach was that it kept a large 
volume of rate data off the network and it decreased the processing load on the central server. 
The disadvantage is that the central server could not display a Near Real Time (NRT) report. 
The only NRT report was a local NRT report, on a satellite server. LIR overcomes this 
disadvantage. If you enable LIR, you can open an NRT report on the central server and 
drill-down on table selections. The selections you make cause the central server to query a 
satellite server for locally aggregated data. Of course, if you would rather copy rate data to the 
central server, you can. If you do that, then enabling LIR is not necessary. 

Device Resource and several other report packs in the February 2009 release have a new copy 
policy import file. When you install Device Resource, PI uses this file to generate copy policies. 
As a result, using the Management Console to create copy policies is no longer necessary. Your 
only task is to verify that the copy policies you need already exist. 

The copy policy enhancement applies to the main package only; it does not apply to the 
Device Resource Backplane sub-package. 

Because you are likely to have multiple satellite servers, we designed the hourly process files 
to be satellite-server friendly. This means that most of the time, most of the defaults are 
correct. But some defaults will be incorrect, or less than optimal, and to improve performance, 
you should change them. 
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Installing Device Resource on Multiple Servers 

Before configuring the servers, verify that package installation was done correctly. Here are 
the guidelines for package installation in a distributed environment: 

•	 Install Device Resource 3.40 and Device Resource Backplane 3.30 (optional) on every server.

•	 Install at least one datapipe on each satellite server. If the Device Resource Backplane 
sub-package is installed, one of the following datapipes must be installed: 

—	 Alcatel Xylan Switch Datapipe 

—	 Cisco Switch Datapipe 

•	 If you want to enable thresholding for aggregated data only, install the thresholds 
sub-package(s) and the Thresholds Module on the central server only. 

•	 If you want to enable thresholding for hourly data or rate data, install the thresholds 
sub-package(s) and the Thresholds Module on each satellite server. 

Configuring the Central Server 

Perform these tasks to configure the central server: 

•	 Task 1: Register the satellite server by setting the database role 

•	 Task 2: If you are not copying rate data to the central server, enable LIR 

•	 Task 3: If you enable LIR, add LIR mappings 

•	 Task 4: Verify the automatically generated copy policies 

•	 Task 5: Modify the trendtimer.sched file 

•	 Task 6: Modify the DeviceResourceReporting_Hourly.pro file 

Task 1: Register the satellite server by setting the database role. 

1 Start the Management Console (log on with Administrator privileges).


2 Click the Systems icon in the navigation pane.


3 Navigate to the PI Databases folder and select the database system.


4	 Click Database Properties. 

5 From the Database Role list, select the Satellite Server role. 

6 Enter any information necessary to configure the Satellite Server role. 

To add a new database reference, you can use the Add Database Reference Wizard in the 
System and Network Administration application. 

Task 2: Enable LIR. 

1 Start the Management Console (log on with Administrator privileges). 

2 Click the Systems icon in the navigation pane. 

3 Navigate to the PI Databases folder and select the central server. 

4 Click LIR Configuration. 
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5 Select the LIR enabled check box. 

Task 3: Add LIR mappings. 

1 Start the Management Console (log on with Administrator privileges). 

2 Click the Systems icon in the navigation pane. 

3 Navigate to the PI Databases folder and select the central server. 

4 Click LIR Configuration. 

5 Click Add Mapping. 

6 From the Select Satellite Server list, select a satellite server to which to add a mapping. 

7 Select the Category data table option. 

8 Select DeviceResources from the drop down list. 

9 Select the rate data type. 

10 Click Add to List. 

11 If you want to add additional LIR mappings, click Add Mapping and repeat step 6 through 
step 10. 

12 Click OK. 

13 Click Apply. 

A copy policy is automatically generated for the hourly data and for each LIR mapping that 
you add. The data type selected when adding an LIR mapping (in step 9 above) determines 
the type of data copied that is defined in the generated copy policy (the type of data copied 
that is defined in the generated copy policy is for one greater than the data type selected in 
the LIR mapping). For example, if you select an hourly data type, a daily data copy policy is 
generated. 

Task 4: Verify that you have all the copy policies you want. 

Verify that a copy policy has been generated for the following tables and that the copy type is 
set correctly (to Property and Data): 

1 Start the Management Console (log on with Administrator privileges). 

2 Click the Copy Policy icon in the navigation pane to start the Copy Policy Manager. 

3 Find the following tables and verify the copy type is set to Property and Data for each 
table: 

• SHDevRes_Device 

• SHDevRes_DeviceMem 

• SHDevRes_Card 

If a copy policy has not been generated for a table, do the following: 

1 Click the New Copy Policy icon or select File > New Copy Policy from the Copy Policy 
Manager. The Copy Policy Wizard displays. 

2 Click Next. The Satellite Server and Copy Policy Selection Page displays. 

3 Select a satellite server from the pull down list. This is the satellite server from which 
data is copied to the central server. 

4 Select Single Table and select the table from the pull down list. 

5 Click Next. The Copy Type Selection Page displays. 
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6 Select Property and Data. 

7 Click Next. The Summary page displays. 

8 Verify the information in the summary window. If the information is not correct, you can 
modify it by clicking Back. 

9 Click Finish. 

10 Repeat step 4 - step 9 for all missing tables.


If the copy type is not set to Property and Data, do the following:


1 Double-click the copy policy. 

2	 Select the Property and Data copy type. 

3	 Click OK. 

Task 5: Modify the trendtimer.sched file 

The trendtimer.sched file is found in the {DPIPE_HOME}/lib/ directory where 
{DPIPE_HOME} is the directory in which PI is installed. 

Make the following change to this file: 

•	 Find and comment out the following line: 

1:00+40 - - {DPIPE_HOME}/bin/trend_proc -f
{DPIPE_HOME}/scripts/DeviceResourceReporting_Hourly.pro 

Task 6:  Modify the DeviceResourceReporting_Hourly.pro file 

The DeviceResourceReporting_Hourly.pro file is found in the 
{DPIPE_HOME}/scripts/ directory where {DPIPE_HOME} is the directory in which PI is 
installed. 

Make the following change to this file: 

•	 Comment out the block1 section. 

Configuring Satellite Servers 

Follow these steps to configure a satellite server: 

1	 If you disable the higher aggregations on a satellite server, you disable local reporting. So 
don’t disable the higher aggregations if you need local reporting. If you do not need local 
reporting, follow these steps to disable daily aggregations: 

•	 Open this file: {DPIPE_HOME}/lib/trendtimer.sched 

•	 Find and comment out the following line: 

24:00+3:00 - - {DPIPE_HOME}/bin/trend_proc -f
{DPIPE_HOME}/scripts/DeviceResourceReporting_Daily.pro 

2 Modify the DeviceResourceReporting_Hourly.pro file: 

The DeviceResourceReporting_Hourly.pro file is found in the {DPIPE_HOME}/
scripts/ directory, where {DPIPE_HOME} is the directory where PI is installed. 

Make the following change to this file: 

•	 Uncomment the block2 section. 
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3 Configure datapipe polling policies; make sure that each network device is polled by one 
satellite server only. 

4 If you are using remote pollers, avoid duplicate polling between remote pollers and 
duplicate polling between a satellite and a remote poller. 

5 If a satellite server has two or more remote pollers, create separate polling policies for 
each remote poller and use views and types to separate the devices. 

System Clocks 

Verify that the system clock on each satellite server is synchronized with the system clock on 
the central server. 
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5 Exception Thresholds 

This chapter covers the following topics: 

• Default thresholds for exceptions 

• Using a form to modify thresholds 

Default Thresholds 

The Device_Resource_Thresholds sub-package imposes an exception threshold on CPU 
utilization, memory utilization, and buffer utilization. When performance reaches one of these 
defaults, the thresholds sub-package sends a trap to the network management system. If your 
PI and NNM servers are integrated, the thresholds sub-package sends the trap to NNM. The 
trap becomes an alarm in the NNM alarm browser. 

The following table describes the condition behind each threshold breach and the severity of 
the alarm sent in response to the breach. 

Metric Threshold Severity 

CPU 85% Medium 

Memory 85% Medium 

Buffer 85% Medium 

You do not have to do anything to enable these thresholds. However, if you want to enable 
multiple types of traps, or set up multiple trap destinations, you must configure the 
Thresholds Module. For details, refer to the Thresholds Module User Guide. 

Updating Thresholds 

Device Resource includes a change form for modifying default thresholds. Follow these steps 
to access the Update Thresholds form: 

1 Click the Objects icon in the panel on the left side of the Management Console window. 
The Object/Property Management view opens. 

Object Manager shows a list of objects. The type of object presented depends on which 
Object Manager View is open: 

• The Device view (the default) shows a list of devices 

• The Customer view shows a list of customers 
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• The Location view shows a list of locations 

2
 To change the view, select View > Change View and use the pop-up window to select a 

different view.


3
 When you see the type of object you are interested in updating, select the particular object 

you would like to update. Object Specific Tasks appears in the window on the right. 


4
 Double-click the task to open the Update Thresholds form, shown below.
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6 Top Ten Reports 

Device Resource contains three Top Ten reports: 

• Customer Top Ten 

• Device Top Ten 

• Location Top Ten 

Use these reports to identify which customers, locations, and devices rank worst in terms of 
CPU, memory, and buffer utilization. The customer report aggregates statistics for groups of 
devices belonging to one customer, while the location report aggregates statistics for groups of 
devices at various locations belonging to one customer. The device report does not aggregate 
data. It displays statistics for the individual devices belonging to one customer. 

In addition to ranking customers, locations, or devices, each Top Ten report also sorts items by 
highest F90 value, the utilization level that PI predicts will be in effect 90 days from today. 
Note that left and right tables are independent and that an item appearing in the worst 
performing table on the left may not appear in the forecast table on the right. If the same item 
appears in both tables, you can assume that yesterday’s performance is part of a longer-term 
trend that may call for corrective action. 

The tables on the left provide statistics for yesterday’s average utilization and yesterday’s 
busy hour. Table entries sort according to average utilization, highest to lowest. The tables on 
the right provide statistics for baseline, F30, F60, and F90; table entries sort by F90 value, 
highest to lowest. Baseline here means average busy hour. 

The Device Top Ten begins with a customer summary table that sorts customers by resource 
utilization, highest to lowest. The Customer Top Ten and the Location Top Ten begin with a 
customer exception count table that sorts customers by yesterday’s total exception count, 
highest to lowest. 

See below for samples of all three Top Ten reports. 
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7 Summary Reports 

Summary reports focus on groups of devices rather than individual devices. If a graph 
monitors utilization for all the devices belonging to one customer, or all the devices in one 
location, you are looking at a summary report. If a graph provides hourly and daily data, and 
the samples that constitute the hourly value and the daily value are based on averages, again 
you are looking at a summary report. 

The customer summary report focuses initially on the threshold exception count for specific 
customers. Customers sort by the number of exceptions, highest to lowest. The graphs below 
track CPU, memory, and buffer utilization. A bar chart displays the exception count 
hour-by-hour and day-by-day, while the Grade of Service chart provides an overall score for 
the customer, hour-by-hour and day-by-day. Use the Customer Summary to look at resource 
utilization customer by customer. 

The location summary is exactly the same as the customer summary, except for the location 
selection table providing an exception count for all the locations belonging to one customer. 
The graphs look at resource utilization for all the devices in one specific location. A bar chart 
displays the exception count hour-by-hour and day-by-day for this location, while the Grade of 
Service chart provides an overall score for this location on an hourly and daily basis. 

The historical summary reports focus initially on busy hour and then provide detailed 
analysis, in the form of hourly and daily aggregations, for individual devices or individual 
cards on one device. The first table sorts customers by aggregated busy hour, highest to 
lowest, allowing you to easily compare one customer to another. Select a customer to populate 
a table of devices belonging to that customer, sorted by resource utilization, highest to lowest. 
Select a device to populate a frequency distribution pie chart and graphs that track average 
and maximum utilization for CPU, memory, and buffer. Here, maximum utilization is a single 
sample, specifically, the highest sample for the hour or for the day, not an average of multiple 
samples. 

Like the historical summaries, the exception summary is device-specific. This report 
focuses initially on exception counts per customer. Select a customer to populate a table 
showing which devices were responsible for those exception counts. Use the hourly graphs to 
find out exactly when those exceptions took place. Compare the hourly graph to the daily 
graph to find out whether yesterday’s exception count is an isolated incident or part of a 
longer-term trend. 

See below for samples of all six summary reports, including the backplane historical 
summary. 
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8 Forecast Reports 

The three forecast reports in Device Resource focus on Days to Threshold (DTT) and provide 
estimates for future utilization. The threshold is 90% utilization, and the value for DTT 
indicates how close the device is to reaching 90% utilization. 

The customer and location reports are actually summary reports, aggregating data by 
customer or by location. The DTT values in these reports are actually averages across all 
devices for that customer, or all devices in that location. For example, if the memory 
utilization DTT is 17 for a customer, many devices could be closer to that threshold while 
many devices could be further away from it. 

If you want to see which customer is closest to a threshold, or which location is closest to a 
threshold, start with the summary reports. If a customer or device looks suspicious, use the 
device report to pinpoint the devices that appear to be causing the problem. The device report 
provides DTT and forecasts for specific devices; the data is not aggregated. 

All three reports use the same criterion for inclusion: a customer, location, or device appears 
in the report if CPU, buffer, or memory utilization is expected to exceed the exception 
threshold sometime within the next 90 days. The three graphs under the DTT data allow you 
to find out which resource is contributing to the problem. Each graph has three tabs: 

• Standard 

• Day of Week 

• History 

Use the standard graph to compare the baseline (average busy hour during the baseline 
period) to F30, F60, and F90. Use the day of week graph to compare the baseline to F30, F60, 
and F90 on a day of week basis and to find out whether resource usage is correlating with a 
particular day of the week. Use the history graph to compare average utilization to busy hour 
utilization over the baseline period. In the hourly graph, average utilization is based on four 
samples. In the daily graph average utilization is based on 96 samples (4 samples per hour, 24 
hours per day). 

The F30, F60, and F90 values are produced by applying linear regression to busy hour values 
recorded over the baseline period. Busy hour is the highest average utilization for the day. 
During that hour, actual utilization may have been considerably higher for at least a portion 
of the hour. Busy hour reflects a persistent event, not a momentary spike. When busy hour is 
high, you want average utilization to be low. If average utilization is high, you know that 
resource utilization has been high for an extended period of time. 
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9 Service Level Management

The Service Level Management report focuses on the availability of individual devices and 
network response time. Use this report to see if availability and network response time are 
meeting levels guaranteed by service level agreements. 

An available device is a device that returns a request from the polling agent. The calculation 
that determines availability has limitations. Although it can compensate for network issues 
that may prevent the device from responding to a polling request, it cannot tell the difference 
between a device that is down and a device that is busy and not able to respond. Given this 
limitation, you may want to use the availability statistics in this report as one indicator of 
device availability, not your only indicator of device availability. 

Network response time is defined as the length of time that elapses from the moment a 
request is sent by the datapipe to the moment the answer is received by the datapipe. This 
perspective on response time is different from the user’s perspective. Since the perspectives 
are different, you should interpret response time increases as an indicator that traffic may be 
congested and that the delay experienced by users may be comparable. 

Selecting a customer from the customer list populates two tables: 

• Devices sorted by availability


• Devices sorted by network response time


The first table sorts devices by availability, highest to lowest. The second table sorts devices 

by busy hour, highest to lowest. 


Selecting a device populates two graphs:


• Device availability, hourly and daily


• Average network response time vs. busy hour network response time


The hourly view of device availability covers a 24-hour period, midnight to midnight. The 

daily view begins with yesterday and covers the previous two weeks. If you see low

availability, or high response time, compare yesterday’s performance with performance over 

the past two weeks to see whether yesterday’s performance is consistent with recent history 

or different from recent history.
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10 Near Real Time Reports

The two Near Real Reports in Device Resource—the QuickView and the Snapshot version of 
the QuickView—focus on resource utilization over the last six hours and the last 24 hours. 
The selection table at the top of the report sorts devices by resource utilization, highest to 
lowest. It displays average utilization for CPU, memory, and buffer, using for input all the 
samples taken during the last six hours, which, in practice, means approximately 24 samples. 
If samples are taken every 15 minutes, then the most recent sample in this average is only a 
few minutes old. 

While the table at the top of the report provides averages for the previous six hours, the CPU, 
memory, and buffer graphs monitor activity over the previous 24 hours. You also have a grade 
of service chart that ranks service quality over the last six hours. Since the Near Real Time 
report is recalculated after every poll, you can use this chart to find out whether a situation 
you are watching closely is improving or getting worse. 

Because the table at the top highlights devices with the worst utilization, you can use the 
NRT QuickView to identify which devices, if any, are having trouble. In addition, if an average 
in the table seems abnormal, you can compare the average in the table to the previous 24 
hours to see if the current average reflects an existing condition or something completely new. 
If a summary report for yesterday points to a situation that could become problematic, the 
Near Real Time report will tell you whether that condition is improving, worsening, or staying 
about the same. The benefit of course is that the advance warning you get from this report 
will let you correct the problem before it becomes a serious issue for users. 

Due to space limitations, the time period in the three rate data graphs may be partially 
concealed. You can easily improve your view of the data by right-clicking the graph, selecting 
View in New Frame, and resizing the window. Once resized, every hour will be clearly 
visible. 

The Snapshot version of the Near Real Time QuickView operates just like the Snapshot 
version of the Historical Summary. Launch the report, then respond to the prompts that ask 
you which device or devices you want included. If a summary, top ten, or forecast report has 
already alerted you to a device with resource problems, and this device is not appearing in the 
NRT QuickView, you can launch the Snapshot version to see where utilization levels are right 
now and what has happened since yesterday. 

See below for samples of these reports: 

• QuickView NRT 

• QuickView NRT Snapshot 

• Backplane NRT 
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A Version History 

Version Release Date Enhancements 

1.00 January 2003 15 reports; Sybase support 

2.00 October 2003 OVPI Object Manager support 
change form: 
• Update Thresholds 
backplane utilization reports: 
• Historical Summary 
• QuickView 
• Snapshot 
• Near Real Time QuickView 
• Near Real Time Snapshot 

3.00 April 2004 Oracle support 
new datapipe: 
• Dev Res Cabletron Datapipe 
upgrade packages: 
• UPGRADE_DeviceResource_to_3 
• UPGRADE_DeviceResourceBackplane_to_3 

3.00 November 2004 new datapipe: 
• Dev Res Juniper Router Datapipe 1.00 

3.10 June 2005 new features: 
• Report linking 
• Launch Point page 
• Ad hoc selector reports 
• Color-coded graphics in selection tables 
upgrade packages: 
• UPGRADE_DeviceResource_to_31 
• UPGRADE_DeviceResourceBackplane_to_31 

3.20 April 2007 new features: 
• Location independent reporting 
• Supports Management Console > Copy Policy 

Manager 

• Report format updates 
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Version Release Date Enhancements 

3.20 April 2007 • Rate data removed from NRT report, top table 
• Alcatel Xylan Switch Datapipe 2.20 
upgrade packages: 
• UPGRADE_DeviceResource_to_32 
• UPGRADE_DeviceResourceBackplane_to_32 
• UPGRADE_DevResEnRouter_to_11 
defect fixes: 
• QXCR1000029126 
• QXCR1000238292 
• QXCR1000352678 

3.30 October 2007 new feature: 
• Copy Policy Enhancement 
new upgrade package: 
• UPGRADE_DeviceResource_to_33 

3.40 February 2009 new upgrade package: 
• DeviceResource_Upgrade_to_34 

(UPGRADE_DeviceResource_to_34.ap) 
• DeviceResourceBackplane_Upgrade_to_33 

(UPGRADE_DeviceResourceBackplane_to_33.ap) 
• DevResEnterasysRouter_Datapipe_Upgrade_to_11

 (UPGRADE_DevResEnRouter_to_11.ap) 
upgrade datapipes: 
• DevResCiscoRouter_Datapipe_Upgrade_to_31 

(UPGRADE_DevResCiscoRouter_to_31.ap) 
• DevResCiscoSwitch_Datapipe_Upgrade_to_32 

(UPGRADE_DevResCiscoSwitch_to_32.ap) 
• DevResEnterasysRouter_Datapipe_Upgrade_to_11

 (UPGRADE_DevResEnRouter_to_11.ap) 
• DevResExtremeDevices_Datapipe_Upgrade_to_21 

(Upgrade_DevResED_DP_to_21.ap) 
• DevResHPProCurveSwitch_Datapipe_Upgrade_to_ 

31 
(UPGRADE_DevResHPProCurveSwitch_to_31.a 
p) 

• DevResJuniperRouter_Datapipe_Upgrade_to_11 
(UPGRADE_DevResJuniperRouter_to_11.ap) 

• DevResNortelBRouter_Datapipe_Upgrade_to_31 
(UPGRADE_DevResNortelBRouter_to_31.ap) 

defect fixes: 
• QXCR1000744267 
• QXCR1000804687 
• QXCR1000823835 
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B PI Report Packs 

Business Technology 

Application 

Database 

HP Business Process Insight 

HP Internet Services 

HP Network Node Manager 

HP Operations 

IP Telephony 

MPLS VPN 

Networking 

Reporting Solution 

Application Report Pack: 
• WebLogic SPI 
• WebSphere SPI 

Database SPI Report Pack 

BPI Report Pack 

Internet Services Report Pack 

NNM Event & Availability Report Pack 

OVO Report Pack 

• Cisco IP Telephony Call Detail 
• Cisco IP Telephony Gateway Statistics 

MPLS VPN Report Pack 

Infrastructure Usage 

• Interface Reporting 
• Device Resource Report Pack 

LAN/WAN Edge 

• Frame Relay (SNMP only) 
• ATM (SNMP only) 

WAN Core 

• Frame Relay (multiple switch vendors) 
• ATM (multiple switch vendors) 

Traffic Profiling 

• RMON II 

• NetFlow Interface 

• NetFlow Global View 

• IP QoS Report Pack 

• Class-Based QoS 
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Business Technology 

Networking (continued) 

System Resources 

Reporting Solution 

Quality Assurance 

• Cisco Ping Report Pack 
• Service Assurance 
• IP Access Rate 

• System Resource Report Pack 
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C Editing Tables and Graphs

Any table or graph can be viewed in several ways. Although the default view is usually 
adequate, you can easily change to a different view. If you are using Report Viewer, right-click 
the object to open a list of view options. If you are using the Web Access Server, follow these 
steps to change the default view of a table or graph: 

1 Click Preferences on the links bar. 

2 Expand Reports in the navigation frame. 

3 Click Viewing. 

4 Select the Allow element editing box. 

5 Click Apply. 

6 Click the Edit icon next to the table or graph. 

View Options for Tables 

Right-clicking a table, or selecting the Edit Table icon if you are using the Web Access Server, 
opens a list of table view options. 

Select Set Time Period to alter the relative time period (relative to now) or set an absolute time 
period. The Set Time Period window opens. 

You may shorten the period of time covered by the table from, for example, 42 days to 30 days 
or to 7 days. If you are interested in a specific period of time that starts in the past and stops 
before yesterday, click Use Absolute Time and select a Start Time and an End Time. 

Select Change Constraint Values to loosen or tighten a constraint, thereby raising or lowering 
the number of elements that conform to the constraint. The Change Constraint Values 
window opens. To loosen a constraint, set the value lower; to tighten a constraint, set the 
value higher. 

The Select Nodes/Interfaces allows you to change the scope of the table by limiting the table to 
specific nodes, specific interfaces, or a specific group of nodes or interfaces. The Select Node 
Selection Type window opens. 
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Change Max Rows increases or decreases the number of rows in a table. The default is 50. If 
you expand the default, the table may take more time to open. If you are trending a large 
network, using the default ensures that the table opens as quickly as possible. 
View in new Frame opens the table in a Table Viewer window, shown below. If necessary, make 
the data in the table more legible by resizing the window. 

View Options for Graphs 

Right-clicking a graph, or clicking the Edit Graph icon if you are using the Web Access Server, 
opens the following list of view options. 
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The following table provides details about each option. 

Option 

Set Time Period 

Change Constraint Values 

Select Nodes/Interfaces 

Displayed Data 

Grid 

Legend 

Style 

Change Max Rows... 

Display Data Table 

Export Element as CSV... 

View in New Frame 

Print Graph 

Function 

Same as the table option shown above. 

Same as the table option shown above. 

Same as the table option shown above. 

For every point on a graph, display data in a 
spreadsheet. 

Add these to the graph: 
X axis grid lines 
Y axis grid lines 
X and Y axis grid lines 

Delete or reposition the legend. 

See the illustrations below. 

Same as the table option shown above. 

See below. 

Same as the table option shown above. 

Opens graph in a Graph Viewer window. 

Same as the table option shown above. 

Style Options 

Select Style to display a list of seven view options for graphs. 
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Style > Area 

The plot or bar chart changes to an area graph. While relative values and total values are 
easy to view in this format, absolute values for smaller data types may be hard to see. Click 
anywhere within a band of color to display the exact value for that location 

To shorten the time span of a graph, press SHIFT+ALT and use the left mouse button to 
highlight the time span you want to focus on. Release the mouse button to display the selected 
time span. 

Style > Stacking Area 

The area or plot graph changes to a stacking area graph. This view is suitable for displaying a 
small number of variables. 
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Style > Bar 

The graph changes to a bar chart. This view is suitable for displaying relatively equal values 
for a small number of variables. There are three variables in the graph below. 

Style > Stacking Bar 

The plot or area graph changes to a stacking bar chart. If you increase the width of the frame, 
the time scale becomes hourly. If you increase the height of the frame, the call volume shows 
in units of ten. 
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Style > Plot 

Bands of color in an area graph change to lines. If you adjust the frame width, you can make 
the data points align with hour; if you adjust the frame height, you can turn call volume into 
whole numbers. 

Style > Pie 

An area graph becomes a pie chart. Bands in an area graph convert to slices of a pie and the 
pie constitutes a 24-hour period. This view is helpful when a small number of data values are 
represented and you are looking at data for one day. 

If you are looking at data for more than one day, you will see multiple pie graphs, one for each 
day. 
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Display Data Table 

This option changes a graph into a spreadsheet. 

View in New Frame 

The graph opens in a Graph Viewer window. Improve legibility by resizing the window. 
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Glossary

Availability 

The percentage of time the device is operational. This measurement accounts for outages 
indicated by the sysUpTime variable; however, it does not account for periods of time the 
device could not be reached by PI. 

Average utilization 

In an hourly graph, this value is an average of four samples taken over a one-hour period. In a 
daily graph, this value is an average of 96 samples taken over a 24-hour period. 

Baseline 

The average busy hour over the baseline period. Rate of growth, a statistic that appears in 
forecast reports, is calculated by dividing F30 by the average busy hour. 

Baseline period 

The previous 91 days. Forecasts for F30, F60, and F90 are based on performance during the 
baseline period. 

Buffer utilization exception 

Recorded when buffer utilization exceeds the allowable threshold. 

Buffer utilization threshold 

When buffer utilization is above this value, an exception is generated. The default value for 
the threshold is 85%. 

Busy Hour 

The definition varies depending on what is being measured. Busy hour is either a busy hour 
total, or a busy hour average. A busy hour total points to the hour of the day that recorded the 
highest number of events, for example, the highest number of buffer utilization exceptions or 
the highest number of memory utilization exceptions. In Device Resource, busy hour is the 
highest hourly average for the day. Busy hour, unlike peak, is a relatively persistent event 
with greater consequences for network users. Compared to busy hour, peak is momentary. 

Since busy hour is an average, you can assume that actual utilization could have been 
significantly higher or lower during the course of that hour. Busy hour average refers to the 
highest hourly average among 24 hourly averages; this term is synonymous with busy hour. 
Average busy hour refers to an average of all busy hour values over the baseline period and is 
synonymous with baseline. 

Card 

Whether or not performance information at the card level is available depends on the make 
and model of the device. Some vendors maintain a distinction between CPU and card, and 
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some do not. Vendors who do maintain the distinction may not maintain it uniformly across 
all equipment. The card selection table in the card historical summary report may contain 
just one entry or it may contain multiple entries. If you see just one entry, either the device 
contains just one card, or the device contains multiple cards but it is not able to report 
multiple cards. If the device cannot report multiple cards, the statistics that display at the 
card level are exactly the same as the statistics that display at the device level. 

Common Property Tables 

Customer names can appear in reports if you import customer names using the Common 
Property Tables package. As explained in the Common Property Tables User Guide, two 
methods of property import are available, a batch-oriented property import utility, and a 
combination of online forms for creating and updating customers, locations, and nodes. If you 
do not import customer names, data from every customer will roll up under All Customers. If 
you do not import locations, data for all locations will roll up under All Locations. 

CPE utilization exception 

Recorded when CPU utilization exceeds the allowable threshold. 

CPU utilization threshold 

When CPU utilization exceeds this value, an exception is generated. The default value for the 
threshold is 85%. 

Daily 

A view of performance that compares average utilization to busy hour utilization. The number 
of days that you can see in this view depends on the number of days that data has been 
collected. The maximum number of days is the rolling baseline, 91 days. Note that daily views 
also include performance data from yesterday, the same data currently visible in the hourly 
view, rolled up as one average and one busy hour. 

Days to Threshold (DTT) 

The number of days that will elapse before utilization is expected to reach 90%. Device 
Resource calculates DTT for CPU utilization, memory utilization, and buffer utilization. 

Device 

A router or a switch, not a server. In selection tables, devices are listed by IP address or 
hostname. 

Grade of Service 

A total score based on a combination of contributing scores, sometimes equally weighted, 
sometimes not. In Device Resource the GOS is equally-weighted and it combines scores for 
memory, buffer, and CPU as follows: 

GOS = 1--- GOS memory + 1--- GOS buffer + 1--- GOS CPU
3 3 3 

Hourly 

An average derived from four collections taken once every 15 minutes; also a graph showing 
yesterday’s hourly increases and decreases. 
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Memory utilization exception 

Recorded when memory utilization exceeds the allowable threshold. 

Memory utilization threshold 

When memory utilization exceeds this value, an exception is generated. The default value is 
85%. 

Near Real Time 

An average for performance over the previous six hours, ending with the most recent poll. If 
polling takes place 4 times per hour, the NRT average is derived from 24 samples. The NRT 
average is a rolling average and is recalculated at the conclusion of each poll. 

Network response time 

The time that elapses from the moment the poller sends an SNMP request to a device to the 
moment the poller receives a response from the device. 

RCT 

Range count. The number of samples that fell above a specified minimum and below a 
specified maximum 

STD 

Standard deviation. Appears as a column in database forecast tables. 

TCT 

The number of samples above a specified value. 

Summary 

An aggregation of multiple samples. In an hourly graph, an average based on multiple 
samples collected during one hour; in a daily graph, an average based on multiple samples 
collected over the course of each day. In customer and location reports, an aggregation of 
multiple averages for multiple devices across the same hour, the same day, or the same 
month. 

Utilization 

Utilization for a time period, measured as a percentage; the value of the metric in use divided 
by the total available resources for that metric, multiplied by 100. 
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We appreciate your feedback! 

If an email client is configured on this system, by default an email window opens when you 
click on the bookmark “Comments”. 

In case you do not have the email client configured, copy the information below to a web mail 
client, and send this email to docfeedback@hp.com 
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Document title:
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